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Dear Candidate, 

 

In preparation for the Web Authoring Using Adobe Dreamweaver CC certification exam, we’ve put 
together a set of practice materials and example exam items for you to review. What you’ll find in 
this packet are: 

• Overview of Topic areas and objectives for the exam. 

• Links to practice tutorials and files 

• Practice exam items. 

We’ve assembled excerpted material from the Dreamweaver Learn & Support site to highlight a 
few of     the more challenging techniques covered on the exam. You can work through these 
technical guides with the provided files (provided separately). Additionally, we’ve included the 
certification objectives     so that you are aware of the elements that are covered on the exam. 
Finally, we’ve included practice exam items to give you a feel for some of the items. 

These materials are meant to help you familiarize yourself with the areas of the exam so are not 
comprehensive across all the objectives. 

Thank you,  

Adobe Education 

https://helpx.adobe.com/support/dreamweaver.html
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Web Authoring using Adobe Dreamweaver 
Exam and objectives 
After taking the exam, your score is electronically reported.  Please allow 2-4 weeks from the date 
you pass the exam to receive your ACA Welcome Kit. 

Exam Structure 
The following lists the topic areas for the exam: 

1. Setting project requirements 

2. Understanding Web Authoring  

3. Understanding Adobe Dreamweaver  

4. Web Authoring Using Adobe Dreamweaver  

5. Testing, Publishing, and Maintaining Web Content Using Adobe Dreamweaver  

Number of Questions and Time 

� 41 questions 

� 50 minutes 

 

Exam Objectives 

Domain 1.0 Setting Project Requirements 

1.1 Identify the purpose, audience, and audience needs for a web authoring project. 

1.2 Summarize how designers make decisions about the type of content to include in a web authoring 
project, including considerations such as copyright, project fit, permissions, and licensing. 

1.3 Demonstrate knowledge of project management tasks and responsibilities. 

1.4 Communicate with others (such as peers and clients) about design plans. 

Domain 2.0 Understanding Web Authoring 

2.1 Demonstrate knowledge of basic web authoring terminology. 

2.2 Demonstrate knowledge of basic design principles and best practices employed in the web authoring 
industry, such as usability, accessibility, consistency, and visual hierarchy.  

2.3 Demonstrate knowledge of Hypertext Markup Language (HTML) and the behavior of basic HTML 
tags. 

2.4 Demonstrate knowledge of Cascading Style Sheets (CSS) and the behavior of basic CSS tags. 

2.5 Demonstrate knowledge of how to author web content that works equally well in various operating 
systems, browser versions/configurations, and devices.  

2.6 Demonstrate knowledge of digital images, text, interactive elements, animation, and video and audio 
content as they pertain to web authoring. 

Domain 3.0 Understanding Adobe Dreamweaver 
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3.1 Identify elements of the Adobe Dreamweaver CC interface and demonstrate knowledge of their 
functions. 

3.2 Identify and define the functions of commonly used panels, including the Insert panel, Property 
Inspector, Assets panel, and Files panel. 

3.3 Navigate, organize, and customize the workspace. 

Domain 4.0 Web Authoring Using Adobe Dreamweaver 

4.1 Define a new Dreamweaver site. 

4.2 Create a web page and define the page layout using HTML, CSS, and structural HTML elements. 

4.3 Add and modify text. 

4.4 Insert and manipulate images, video, sound, interactive elements, and animation. 

4.5 Link web content, using hyperlinks, email links, and named anchors. 

4.6 Create and manage special content types in a web authoring project, including tables and forms. 

Domain 5.0 Testing, Publishing, and Maintaining Web Content Using Adobe Dreamweaver 

5.1 Conduct technical and usability tests.  

5.2 Manage assets, links, and files for a site.  

5.3 Publish and update site files to a remote server.  

5.4 Demonstrate knowledge of how to optimize web content to make it visible to search engines.  

 

  



Web Authoring Using Adobe Dreamweaver CC Study Guide 

 

 
Adobe, the Adobe logo, Adobe Photoshop and Creative Cloud are either registered trademarks or trademarks of Adobe Systems 
Incorporated in the United States and/or other countries. All other trademarks are the property of their respective owners. 
 
© 2017 Adobe Systems Incorporated. All rights reserved. 

4 

Understand the Anatomy of a Website 
Source: Anatomy of Website Construction 

Learn how most web pages are made using HTML and CSS. 

When you look at a web page, you might wonder how it is made. To display a web page, your Internet 
browser reads and interprets a special set of instructions. These instructions are written primarily in 
two languages: HTML and CSS. 

The World Wide Web Consortium (W3C) defines the web standards, or specifications, for these 
languages. It is important to understand web standards to ensure that the different web browsers 
display your pages accurately. Dreamweaver includes features that allow you to build web pages 
based on the latest web standards. Let's look at how HTML and CSS work together to make a web 
page. 

What is HTML? 

Web pages display content and have an underlying structure defined by HTML. The content can 
include text, images, links, or even audio and video. Most HTML elements are written using 
opening <element> and closing </element>tags that tell the browser what type of content to display. 
The tags are written in a specific order to define the structure of the page. The example below shows 
three common HTML tags. 

• <h1> specifies heading text, good for page titles 

• <p> specifies paragraph text, good for body text 

• <img> displays an image specified by a src (source file) 

Note: The HTML in this example displays in upper case to illustrate the concepts more clearly. 
However, it is best practice to write HTML tags in lower case when coding your own pages.  

 
What is CSS? 

With HTML you've given a basic structure to your web page, but there's not much customization to the 
style or layout. Eventually you want to add colors, format text and images, and reposition elements on 

https://helpx.adobe.com/dreamweaver/how-to/anatomy-of-website-construction.html
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your page. CSS is a language that works with HTML to apply this style and formatting to your web 
page. Use CSS to find one or more HTML elements, and then provide additional instructions for what 
to do with that element (such as change its color or center it on the page). 

The example below shows how CSS is used to change the appearance of the three HTML elements. 

• h1 The heading text is center-aligned. 

• p The paragraph text is red, bold, and center-aligned. 

• img The image is resized to 150px by 100px. 

 
 

Introduction to HTML  
Before you learn about Cascading Style Sheets (CSS), you should have a basic understanding of HTML, 
the programming language used to create web pages. 

The structure and appearance of a web page is controlled by its underlying code. The programming 
language used to write this code for web pages is Hypertext Markup Language, or HTML. 

If you view the code for most web pages, you will see line after line of ordinary text, surrounded by 
short commands called HTML tags. These tags are placed in brackets at the beginning and end of 
blocks of text and tell a web browser how to display or interact with information between the tags. 
Tags are enclosed by angle brackets (<>) and usually come in pairs with a start (or opening) and end 
(or closing) tag. The HTML tags themselves are not displayed in the browser. 

• <p>This is a paragraph of text.</p> 

• <p> = Start tag 

• </p> = End tag 

When you create a web page by using Dreamweaver in Design view, the HTML code is created 
automatically. These are common tags you will see when working in Dreamweaver: 

• <html></html> describes the web page 
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• <head></head> describes the header of the web page 

• <body></body> describes visible page content 

• <h1></h1> displays a heading, ranging in size from 1 (biggest) to 6 (smallest) 

• <p></p> formats text as a paragraph 

• <strong></strong> bolds text 

• <em></em> emphasizes text, displays as italics 

• <br> creates a line break 

• <a href="http://www.example.com"></a> creates a link to a web page 

Note: Dreamweaver uses code coloring to help you identify general categories of tags and code 
elements in Code view. 

Although HTML includes tags for displaying text, images, tables, and other page elements, it has 
limited precision in page layout and formatting—a frustration for many designers. 

 

Follow the stages of web design 
Source: Stages of Web Design 

Whether designing your own site, or working as a team, the process of bringing a website to the web 
can be deconstructed into manageable phases. 

1. Plan your content 

Planning good content is arguably the most important phase in web design. This is also the stage that 
can take the longest amount of time, but it is worth doing it well. A good content plan will increase the 
presence and usability of your site as well as speed up web development. 

Some key points to keep in mind are to know your audience, short and concise is usually better, think 
about how others will search for your site, and organize content logically. 

 
2. Wireframe your design 

A wireframe is a blueprint, or an abstract visual representation, of a website that makes it easier for 
you and your team to collaborate during the design and planning stage. Wireframes can be simple 

http://www.example.com/
https://helpx.adobe.com/dreamweaver/how-to/stages-web-design.html?playlist=/ccx/v1/collection/product/dreamweaver/segment/designer/explevel/beginner/applaunch/orientation/collection.ccx.js
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diagrams drawn by hand for quickly getting ideas down wherever you are, or they can be a more 
complex definition of a website's navigation and functionality. 

A variety of wireframing tools are available to you including pen and paper, free or commercial 
wireframe software apps, or even other Creative Cloud apps such as Photoshop, Illustrator or XD. 
Choose the method and level of detail that work best for you and your team. 

 
 

3. Create web pages 

Now it's time to put that great design and planning into action. To bring a conceptual plan to life, it is 
important to understand the languages of web design. The main focus for this series will be on HTML 
and CSS with a sneak peek into JavaScript. 

HTML, or Hypertext Markup Language, is used to create the overall structure and content of the pages 
in your website. CSS, aka Cascading Style Sheets, is used to style visual properties of website's content 
and customize the layout. JavaScript is a popular language you can use to add functionality and 
interactivity to web pages. 

 
4. Publish your website 

Once you are ready to publish your website for the world to see, you'll need a few things. First, you'll 
have to get a domain name, or web address. You will also need dedicated space on a web server and 
the connection details – FTP is a common way to connect to a web server. If you are creating a 
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website for your company, you can get this information from your IT web admin. If you are publishing 
your own site, you can get this information from a web host provider. 

You can then use the Sites feature to connect to the web server and publish your site straight from 
Dreamweaver. 

 
 

Web development using Dreamweaver - An Overview 
Source: Web development using Dreamweaver 

This article helps you understand how you can complete various stages or phases of web 
development using Dreamweaver. 

Note: This article assumes that you have a beginner to intermediate level of understanding of the web 
domain, and HTML, CSS, and JavaScript. 

1. Analyze the audience needs, technical, and marketing requirements. You also gather 
necessary information required for designing and publishing your website and have answers 
for questions like some of these: 

• Which service provider do I choose for hosting the website? Do I have access to 
upload files to the publishing server? 

• What domain name is to be used for the website? 

• In case you are migrating existing websites into Dreamweaver, where are the files and 
assets stored currently? Do I have access to the server where this information is stored? 

• If you want a dynamic website, which server can I use to test if data is being displayed 
dynamically? Do I have the details of the web application server that I want to use for 
loading dynamic data? 

• What kind of assets are required for the website? 

• Will these be assets designed from scratch? If the assets are already available, do I have 
access to them? 

• What apps do I want to use for designing assets? 

• Do I plan to create a responsive website?  

https://helpx.adobe.com/dreamweaver/using/web-development-using-dreamweaver---an-overview.html
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Assuming that you have a clear understanding of the website you want to develop and how and 
where you want to host it, and have chosen Dreamweaver and Creative Cloud for the web 
development process, proceed to the next step. 

2. Check if you have all the assets required for your website.  
Gather and organize them together in your local folders or in Adobe's Creative Cloud 
Libraries. 

3. Create a new document in Dreamweaver using: 

• A new blank document, 

• Starter templates packaged with Dreamweaver, or  

• Template files (*.dwt) created by someone else 

Note: If you are not familiar with Dreamweaver or just learning web development, starter 
templates are a great help in getting you up and running with designing web pages. Even if you are 
planning to start from scratch, it is a good idea to peek a little into these pages to understand the 
elements of a good web page design. 

4. Take a few minutes to familiarize yourself with the Dreamweaver workspace.  
Find a workspace you are comfortable with, and set a color theme. Reorganize the different 
panels in a way that suits you. 

5. Set up your site in Dreamweaver.  
Set about creating a folder structure with files and assets. After you’ve organized your 
information and determined a structure, you can begin creating your site. (See About 
Dreamweaver sites.) At this stage, it is a good idea to also set up connections to remote 
servers, and set up testing servers (if you have dynamic content).  

6. Start coding your web pages in Code view, or designing them in Design / Live view. 
If you plan to use Photoshop comps, you can extract them into Dreamweaver and work on 
them too. For more information on working with Photoshop comps, see Extract in 
Dreamweaver CC. 
Add design elements such as text, images, rollover images, image maps, colors, movies, sound, 
HTML links, tables, and more. 

7. Style the appearance of your web page using CSS.  
You can work with CSS in different ways in Dreamweaver: 

• You can hand code the CSS. For information on Dreamweaver's coding features that 
help you hand code your CSS, see Coding environment in Dreamweaver. 

• If you are not very familiar with creating CSS pages, you can use the CSS Designer 
panel to help build your CSS. For more information, see Laying out pages using CSS 
Designer. 

• If you prefer to work with Sass and Less files, Dreamweaver supports that option as 
well, allowing you to bring in Sass and Less files into your Dreamweaver site, and work 
with them. Dreamweaver then autocompiles them (or you can choose to manually 
compile them) and see the results of your CSS changes in real time. For information on 
using Sass and Less files with Dreamweaver, see CSS preprocessors. 

https://helpx.adobe.com/dreamweaver/using/dreamweaver-sites.html
https://helpx.adobe.com/dreamweaver/using/dreamweaver-sites.html
https://helpx.adobe.com/dreamweaver/using/dreamweaver-integration-extract.html
https://helpx.adobe.com/dreamweaver/using/dreamweaver-integration-extract.html
https://helpx.adobe.com/dreamweaver/using/setting-coding-environment.html
https://helpx.adobe.com/dreamweaver/using/css-designer.html
https://helpx.adobe.com/dreamweaver/using/css-designer.html
https://helpx.adobe.com/dreamweaver/using/css-preprocessors.html
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8. Set up a web application for creating dynamic content. 
Many websites contain dynamic pages that allow visitors to view information stored in 
databases, and usually allow some visitors to add new information and edit information in the 
databases. To create such pages, you must first set up a web server and application server, 
create or modify a Dreamweaver site, and connect to a database. For more information, 
see Dynamic sites, pages and web forms. 

9. Create dynamic pages. 
In Dreamweaver, you can define a variety of sources of dynamic content, including recordsets 
extracted from databases, form parameters, and JavaBeans components. To add the dynamic 
content to a page, simply drag it on to the page. 
 
You can set your page to display one record or many records at a time, display more than one 
page of records, add special links to move from one page of records to the next (and back), 
and create record counters to help users keep track of the records. For more information, 
see Dynamic sites, pages and web forms. 

10. Test, preview, and publish your website.  
As you create pages, you need to preview them to see that your website is progressing 
according to the design. You can code in Split view keeping your Code and Live views side-by-
side. 
 
You can also preview web pages in real time on a device (if you are creating responsive web 
pages), or on a browser. If you don't need a live preview experience, you can use the regular 
preview in browser experience. 
 
If you have already defined connections to remote servers, then to publish your website, you 
need to put your files in the remote server to make them live. 

 

Overview of Adobe Dreamweaver 
Onboarding Dreamweaver 

After installing Dreamweaver, when you first launch the application, a QuickStart menu appears on the 
screen asking you three questions that help you personalize your Dreamweaver workspace according 
to your needs. 

Based on your responses to these questions, Dreamweaver opens in a Developer workspace (a 
minimal code-focused layout), or a Standard workspace (a split layout with visual tools and an in-app 
preview as you code).  

After you choose a workspace, you choose a color theme that you are comfortable with. You can then 
get started. 

Workspace overview 

The Dreamweaver workspace lets you view documents and object properties. The workspace also 
places many of the most common operations in toolbars so that you can quickly make changes to 
your documents. 

https://helpx.adobe.com/dreamweaver/topics/web-applications-forms.html
https://helpx.adobe.com/dreamweaver/topics/web-applications-forms.html
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A. Application bar B. Document toolbar C. Document window D. Workspace 
switcher E. Panels F. Code View G. Status bar H. Tag selector I. Live View J. Toolbar  

 

Workspace elements overview 

The workspace includes the following elements: 

The Application bar: Is across the top of the application window and contains a workspace 
switcher, menus (Windows only), and other application controls. 

The Document toolbar: Contains buttons that provide options for different views of 
the Document window (such as Design view, Live view, and Code view). 

The Standard toolbar: To display the Standard toolbar, select Window > Toolbars > Standard. 
The toolbar contains buttons for common operations from 
the File and Edit menus: New, Open, Save, Save All, Print Code, Cut, Copy, Paste, Undo, 
and Redo. 

The toolbar: Is on the left side of the application window and contains view-specific buttons. 

The Document window: Displays the current document as you create and edit it. 

The Property inspector: Lets you view and change a variety of properties for the selected 
object or text. Each object has different properties. 

The Tag selector: Located in the Status bar at the bottom of the Document window. Shows 
the hierarchy of tags surrounding the current selection. Click any tag in the hierarchy to select 
that tag and all its contents. 

Panels: Help you monitor and modify your work. Examples include the Insert panel, the CSS 
Designer panel, and the Files panel. To expand a panel, double-click its tab. 

The Extract panel: Lets you upload and view your PSD files on Creative Cloud. Using this 
panel, you can extract CSS, text, images, fonts, colors, gradients, and measurements from your 
PSD comps into your document. 

The Insert panel: Contains buttons for inserting various types of objects, such as images, 
tables, and media elements, into a document. Each object is a piece of HTML code that lets 
you set various attributes as you insert it. For example, you can insert a table by clicking 
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the Table button in the Insert panel. If you prefer, you can insert objects using the Insert menu 
instead of the Insert panel. 

The Files panel: Lets you manage your files and folders, whether they are part of a 
Dreamweaver site or on a remote server. TheFiles panel also lets you access all the files on 
your local disk. For more information, see Manage files and folders. 

The Snippets panel: Lets you save and reuse your code snippets across different web pages, 
different sites, and different installations of Dreamweaver (using sync settings). For more 
information, see Reuse code with snippets. 

The CSS Designer panel: a CSS Property Inspector that lets you "visually" create CSS styles, 
files, and set properties, along with media queries. 

Refer to the Dreamweaver Workspace and Views section of the User Guide for the most up-to-date 
information about each specific Dreamweaver workspace element. 

 

Set up sites 
Learn how to set up sites in Dreamweaver, connect to remote and testing servers, and perform other 
site management operations. 

• About Dreamweaver sites: Learn how sites work in Dreamweaver and understand why 
creating sites in Dreamweaver is important for your workflow. 

• Set up a local version of your site: Learn how to set up a local version of your web site as a 
Dreamweaver site and use the Manage Sites dialog box to set up multiple sites and manage 
them. 

• Connect to a publishing server: Set up FTP, SFTP, WebDav, or RDS connections to upload or 
download files from the publishing web server. 

• Accessibility features in Dreamweaver: learn how to use Dreamweaver to make websites and 
web products usable for people with visual, auditory, motor, and other disabilities. 

See the Set Up Sites documentation in the Dreamweaver User Guide for additional information about 
site management. 

 

Manage files 
The list of resources below will help you learn how to manage the files in your website in 
Dreamweaver. Create and open different file types, manage files and folders, check in and check out, 
transfer them to remote sites, and perform other such file operations. 

• Create and open files: Create, open, edit, save, and revert files in Dreamweaver. Create 
templates and open related files. 

• Manage files and folders: Learn how to use the Files panel to manage, transfer, and 
synchronize files and folders between local and remotes sites in Dreamweaver. Also learn how 
the auto-recovery feature works in Dreamweaver. 

• Getting and putting files to and from your server: learn how to get and pull files to and from 

https://helpx.adobe.com/dreamweaver/using/files-folders.html
https://helpx.adobe.com/dreamweaver/using/reuse-code-with-snippets.html
https://helpx.adobe.com/dreamweaver/using/dreamweaver-workflow-workspace.html
https://helpx.adobe.com/content/help/en/dreamweaver/using/dreamweaver-sites.html
https://helpx.adobe.com/content/help/en/dreamweaver/using/set-local-version-site.html
https://helpx.adobe.com/content/help/en/dreamweaver/using/connect-remote-server.html
https://helpx.adobe.com/content/help/en/dreamweaver/using/dreamweaver-accessibility.html
https://helpx.adobe.com/dreamweaver/user-guide.html?topic=/dreamweaver/morehelp/set_up.ug.js
https://helpx.adobe.com/content/help/en/dreamweaver/using/creating-opening-documents.html
https://helpx.adobe.com/content/help/en/dreamweaver/using/files-folders.html
https://helpx.adobe.com/dreamweaver/using/getting-putting-files-server.html
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your server, and manage file transfers using Dreamweaver. 

To learn more about how to manage files with Dreamweaver including how to synchronize files, 
comparing local and remote files, etc. visit the Manage Files section of the Dreamweaver User Guide. 

 

Layout and design 
In this section you will learn more about how you can use CSS, tables, and Dreamweaver’s visual aids 
to lay out and design your web pages. In addition, you will learn about responsive design using 
Bootstrap. 

• Use visual aids for layout: learn how to Use visual aids for layout in Dreamweaver, including 
setting rulers, setting layout guides, using guides with templates, and using a layout grid. 
(Please note that the “Use a tracing image” functionality is not included on the exam).  

• Design responsive websites using Bootstrap: for a mobile-first, responsive website, use 
Bootstrap starter templates and drag-and-drop Bootstrap components in Dreamweaver. 

• Responsive design using fluid grid layouts: learn how to use fluid grids to design websites for 
mobile devices and desktops. 

• Present content with tables: Learn how to use tables to present content in your web site. Also, 
learn how to split and merge table cells, and import and export tabular data. 

• Picking colors: learn about web-safe colors and how to use the color picker to pick colors for 
your Dreamweaver site. 

 

CSS in Dreamweaver 
Cascading Style Sheets (CSS) is a style sheet language that you can use to describe the presentation of 
a website. Read this set of articles to learn how you can use CSS to lay out and design your webpages 
in Dreamweaver. 

• Understand Cascading Style Sheets (CSS): learn the basic concepts of CSS such as CSS rules, 
selectors, inheritance, and more. Also, learn how to associate CSS with your web pages in 
Dreamweaver. 

• About using CSS to lay out your page: learn the basic structure of a CSS layout and how to 
design pages and content using CSS in Dreamweaver. 

• Laying out pages using CSS Designer: Learn how to use the CSS Designer panel to create or 
attach stylesheets, media queries, selectors, and set CSS properties. 

• How to set CSS Style preferences in Dreamweaver: Learn how to use CSS style preferences to 
control how Dreamweaver writes the code that defines CSS styles. 

• Move CSS rules in Dreamweaver: Move, export, or rearrange CSS rules to a new style sheet or 
to an existing style sheet in Dreamweaver. 

• Convert inline CSS to a CSS rule in Dreamweaver: Learn how to make your CSS cleaner and 
more organized by converting inline styles to CSS rules in Dreamweaver. 

 

https://helpx.adobe.com/dreamweaver/user-guide.html?topic=/dreamweaver/morehelp/file_management.ug.js
https://helpx.adobe.com/content/help/en/dreamweaver/using/using-visual-aids-layout.html
https://helpx.adobe.com/content/help/en/dreamweaver/using/bootstrap.html
https://helpx.adobe.com/content/help/en/dreamweaver/using/responsive-design-fluid-grid-layouts.html
https://helpx.adobe.com/content/help/en/dreamweaver/using/presenting-content-tables.html
https://helpx.adobe.com/content/help/en/dreamweaver/using/colors.html
https://helpx.adobe.com/content/help/en/dreamweaver/using/cascading-style-sheets.html
https://helpx.adobe.com/dreamweaver/using/css-layouts.html
https://helpx.adobe.com/content/help/en/dreamweaver/using/css-designer.html
https://helpx.adobe.com/content/help/en/dreamweaver/using/set-css-styles-preferences.html
https://helpx.adobe.com/content/help/en/dreamweaver/using/move-export-css-rules.html
https://helpx.adobe.com/content/help/en/dreamweaver/using/convert-inline-css-css-rule.html
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Page content and assets 
Learn to manage page content and assets in Dreamweaver - text, and assets such as images, and 
media objects.  

• Set page properties: Learn how to set HTML page properties and CSS properties, such as font, 
background color, and background image properties, for your Dreamweaver page. 

• Set CSS heading properties and CSS link properties: Learn how to set CSS heading properties 
and CSS link properties and apply them to all headings and links on the page. 

• Work with text: Learn how add and format text in Live view, Code view, or by extracting text 
and the associated properties from PSD files. 

• Work with assets: learn how to use the Assets panel to manage assets in the current site. 

• DOM panel: Learn how to use the DOM panel to edit the HTML structure by mapping 
elements in Live View or applied selectors in CSS Designer with their HTML markup. 

• Insert and edit images: learn how to insert, edit, replace, and resize images and image 
placeholders in your web pages. 

• Add media objects: learn how to insert and edit media objects in Dreamweaver web pages, 
use Design Notes, and more.  

• Edit in Live View: Learn how to design, edit, and preview your web pages in Live View. 
Rearrange or insert elements, apply selectors, edit image attributes, insert, edit, and format 
text without switching to Code View. 

Learn more about managing page content and assets in the Page Content and Assets section of the 
Dreamweaver User Guide.  

 

Linking and navigation 
Use the resources below to learn how you can manage navigation (and troubleshoot link issues) in 
your website. 

• About linking and navigation: learn about linking and navigation in Dreamweaver and 
absolute, document-relative, and site root-relative paths. 

• Linking: learn how to set up navigation between your web pages and link to files and 
documents. Also, learn how to update, change, and test links. 

• Image maps: learn how to use image maps in Dreamweaver to create interactive hotspots for 
your website. 

• Troubleshoot links: Find and fix broken, external, and orphaned links in Dreamweaver. 

 

Coding websites in Dreamweaver 
Dreamweaver offers a variety of coding tools that making the task of coding websites easier. Review 
the resources below to learn about Dreamweaver's coding features - such as code hints, code coloring, 
code collapse, snippet reuse, multi-cursors, code linting, and more. 

https://helpx.adobe.com/dreamweaver/using/set-page-properties.html
https://helpx.adobe.com/content/help/en/dreamweaver/using/set-css-heading-properties-entire.html
https://helpx.adobe.com/content/help/en/dreamweaver/using/text.html
https://helpx.adobe.com/dreamweaver/using/assets.html
https://helpx.adobe.com/content/help/en/dreamweaver/using/dom-panel.html
https://helpx.adobe.com/content/help/en/dreamweaver/using/insert-edit-images.html
https://helpx.adobe.com/content/help/en/dreamweaver/using/adding-media-objects.html
https://helpx.adobe.com/content/help/en/dreamweaver/using/edit-in-live-view.html
https://helpx.adobe.com/dreamweaver/user-guide.html?topic=/dreamweaver/morehelp/content_and_assets.ug.js
https://helpx.adobe.com/dreamweaver/user-guide.html?topic=/dreamweaver/morehelp/content_and_assets.ug.js
https://helpx.adobe.com/content/help/en/dreamweaver/using/linking-navigation.html
https://helpx.adobe.com/content/help/en/dreamweaver/using/linking.html
https://helpx.adobe.com/content/help/en/dreamweaver/using/image-maps.html
https://helpx.adobe.com/content/help/en/dreamweaver/using/troubleshooting-links.html
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• About coding in Dreamweaver: learn about how Dreamweaver supports the different coding 
languages that are used to build websites. 

• Coding environment in Dreamweaver: learn how you can use the coding environment in 
Dreamweaver to speed up the process of writing code. 

• Set coding preferences: learn how to set coding preferences, code themes, format, and code 
rewriting preferences in Dreamweaver. 

• Customize code coloring: learn how you can customize the colors of your code elements 
(code coloring) such as code comments in Dreamweaver. 

• Write and edit code: learn how to work in code view and get the best out of Dreamweaver's 
coding features. 

• Code hinting and code completion: use Dreamweaver's code hinting and code completion 
features to minimize coding time. 

If you are interested in learning more about the coding tools in Dreamweaver visit the Coding 
Websites documentation in the user guide. 

 

Mobile and multiscreen 
Learn how you can design for mobile and multiple screens in Dreamweaver. 

• Create media queries: learn how to create adaptive websites in Dreamweaver using media 
queries. Set up media queries for tablets, phones, or any other screen size, and use them in 
your stylesheets. 

• Create web apps for mobile devices using Dreamweaver: use Dreamweaver to design a web 
application that works on mobile devices while adapting itself to the dimensions of the device. 

• Changing page orientation for mobile devices: learn how to view Dreamweaver web pages in 
Landscape or Portrait when viewed in mobile devices. 

 
  

https://helpx.adobe.com/content/help/en/dreamweaver/using/general-information-coding-dreamweaver.html
https://helpx.adobe.com/content/help/en/dreamweaver/using/setting-coding-environment.html
https://helpx.adobe.com/content/help/en/dreamweaver/using/setting-coding-preferences.html
https://helpx.adobe.com/content/help/en/dreamweaver/using/customize-code-coloring.html
https://helpx.adobe.com/content/help/en/dreamweaver/using/writing-editing-code.html
https://helpx.adobe.com/content/help/en/dreamweaver/using/code-hints.html
https://helpx.adobe.com/dreamweaver/user-guide.html?topic=/dreamweaver/morehelp/coding.ug.js
https://helpx.adobe.com/dreamweaver/user-guide.html?topic=/dreamweaver/morehelp/coding.ug.js
https://helpx.adobe.com/content/help/en/dreamweaver/using/creating-media-queries-cs5-5.html
https://helpx.adobe.com/content/help/en/dreamweaver/using/creating-web-applications-mobile-devices.html
https://helpx.adobe.com/content/help/en/dreamweaver/using/change-page-orientation-mobile-devices.html
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Using Dreamweaver to Create and Publish Websites  
Below is a list of tutorials and resources from the Adobe Education Exchange and the Dreamweaver 
Learn & Support page that you can use in your classroom to prepare your students to be successful on 
the ACA exams.  

 

Analyzing websites (Lesson) 

Related to domains 1 and 2 

Analyzing websites to inform design decisions is a common practice among professional designers. In 
the real world designer's look to one another's work to assess what works, what doesn't, and to keep 
tabs on new industry standards and trends. Use this activity to teach your students how to analyze 
websites to determine their audience, purpose, validity, usability, and accessibility in order to help 
inform their future design decisions. 

Design Principles (Lesson) 

Related to domain 2 

Designers use design principles to evaluate and inform the consistency and visual hierarchy of their 
design. Put into action, design and typographic principles, can then be used to make sure designs 
reach an intended target audience and/or meet the goals of a company or individual. Use this activity 
to introduce the how to use design principles and typography so students can evaluate and inform 
their designs. 

Define a site 

Related to domains 2 and 4 

Right from the start, let Adobe Dreamweaver help you organize your files and links so your site is easy 
to manage and performs beautifully. 

Defining page structure with HTML 

Related to domains 2, 3, and 4 

A well-defined web page structure provides the foundation for your layout and styling. See how to use 
Hypertext Markup Language (HTML) to structure pages in Adobe Dreamweaver. 

Layout and style pages with CSS 

Related to domains 2, 3, and 4 

Use Cascading Style Sheets (CSS) to position elements on your web pages and apply color in Adobe 
Dreamweaver. 

Add content to your webpages 

Related to domains 2, 3 and 4 

Add page titles, headings, paragraphs, lists, and images to your web pages using HTML in Adobe 
Dreamweaver. 

Inserting content in Dreamweaver 

Related to domain 3 and 4 

http://edex.adobe.com/
https://helpx.adobe.com/dreamweaver.html
https://helpx.adobe.com/dreamweaver.html
https://edex.adobe.com/resource/5d7b56
https://edex.adobe.com/resource/23191da5/
https://edex.adobe.com/resource/23191da5/
https://helpx.adobe.com/dreamweaver/how-to/define-a-dreamweaver-site.html?playlist=/ccx/v1/collection/product/dreamweaver/segment/designer/explevel/beginner/applaunch/orientation/collection.ccx.js
https://helpx.adobe.com/dreamweaver/how-to/define-a-dreamweaver-site.html?playlist=/ccx/v1/collection/product/dreamweaver/segment/designer/explevel/beginner/applaunch/orientation/collection.ccx.js
https://helpx.adobe.com/dreamweaver/how-to/work-with-html-layout.html
https://helpx.adobe.com/dreamweaver/how-to/work-with-html-layout.html
https://helpx.adobe.com/dreamweaver/how-to/learn-css-basics-of-web-page-layout.html?playlist=/ccx/v1/collection/product/dreamweaver/segment/designer/explevel/beginner/applaunch/basictraining/collection.ccx.js
https://helpx.adobe.com/dreamweaver/how-to/learn-css-basics-of-web-page-layout.html?playlist=/ccx/v1/collection/product/dreamweaver/segment/designer/explevel/beginner/applaunch/basictraining/collection.ccx.js
https://helpx.adobe.com/dreamweaver/how-to/work-with-html-text.html
https://helpx.adobe.com/dreamweaver/how-to/work-with-html-text.html
https://edex.adobe.com/resource/4c39--
https://edex.adobe.com/resource/4c39--
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Text, links, and graphics are integral parts of a web project. When working on any web project they 
will need to know how to add and style text, add images and graphics, and create links. Use this 
activity to introduce your students to working with links, text, and images and graphics by using Adobe 
Dreamweaver. 

How to create a web form 

Related to domain 3 and 4 

Creating a web form is an essential tool for collecting information from your website’s viewers. Forms 
are used everywhere on the web, to contact someone in a company, subscribe to a mailing list, 
register for an event, collect payment information, submit surveys, and much more. 

Create bulleted and numbered lists 

Related to domain 3 and 4 

Learn how to create bulleted and numbered lists in Dreamweaver. 

Code HTML, CSS, and JavaScript faster: learn how Dreamweaver can complete HTML, CSS, and 
JavaScript code as you type. You can also preview colors and images as you work, quickly navigate 
through your code, and learn coding definitions without leaving the app. 

Publish and manage websites 

Related to domain 5 

When you’re ready to share your site with the world, see how Adobe Dreamweaver helps you publish 
for the first time and manage updates. 

How to make a website in Dreamweaver 

Related to domains 2, 3, and 4 

This eight-part tutorial series is designed to help you guide you through building a simple, yet elegant 
website in Dreamweaver CC 2015. This series takes you from site setup to publishing. 

Create a responsive menu 

Related objectives: Domain 1, Domain w 

Digital design curriculum 

Digital Design is a year-long, project-based curriculum that develops key digital communication skills 
such as design, project management, research and communication, and web planning, design and 
development technical skills using Adobe tools. 

ACA TestPrep: Web Authoring Using Dreamweaver CC 2015 

Requires Paid Subscription. Covers all domains. Three complimentary videos related to Domain 1 

This tutorial series is specially designed to cover the latest ACA exam standards as they’re addressed in 
the new Creative Cloud versions of the examination. With special attention paid to the new 
Dreamweaver CC interface elements, this series of 49 videos is a perfect way for students to learn the 
fundamentals of creating HTML and CSS  

https://helpx.adobe.com/dreamweaver/how-to/create-web-form.html
https://helpx.adobe.com/dreamweaver/how-to/create-web-form.html
https://helpx.adobe.com/dreamweaver/how-to/create-bulleted-numbered-lists.html
https://helpx.adobe.com/dreamweaver/how-to/create-bulleted-numbered-lists.html
https://helpx.adobe.com/dreamweaver/how-to/code-faster-fewer-errors.html?playlist=/ccx/v1/collection/product/dreamweaver/topics/html/collection.ccx.js
https://helpx.adobe.com/dreamweaver/how-to/publish-manage-websites.html
https://helpx.adobe.com/dreamweaver/how-to/publish-manage-websites.html
https://helpx.adobe.com/dreamweaver/how-to/make-website-pt1-site-setup.html
https://helpx.adobe.com/dreamweaver/how-to/make-website-pt1-site-setup.html
https://edex.adobe.com/digital-design
https://edex.adobe.com/digital-design
https://edex.adobe.com/resource/c31dc517/
https://edex.adobe.com/resource/c31dc517/
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Sample Questions 
Dreamweaver CC 2015 

All sample questions have been provided by GMetrix. For information about full practice exams and 
additional exam preparation materials, visit GMetrix.com. 

 
Selected Response Questions 

1. Which of the following is used to lock the 
proportions of a table regardless of 
different display sizes? 

a. Percentage 

b. Lock Table 

c. Fixed Pixel 

d. Relative 

 

2. Which of the following are effective ways 
of gathering website feedback (choose 3)? 

a. E-mail a link requesting feedback 

b. Forms 

c. Website usability testing 

d. Personal interviews 

 

3. Because more and more people are 
accessing websites from their mobile 
device, it's important to make sure your 
site displays correctly on mobile. Which of 
the following are options for building a 
smartphone-optimized web page? 
(Choose three) 

a. Responsive web design 

b. Device-specific HTML 

c. Designing separate mobile and 

desktop sites 

d. Hybrid Site Design (HSD) 

 

4. After doing some research you have 
learned that there are some tools you 
need to use to create your site. Which of 
the following describes a remote folder? 

a. A password protected location for 
final file versions 

b. The location where all the multimedia 
type files are stored 

c. The folder where Dreamweaver 
processes dynamic pages 

d. It stores your files online for testing, 
production, and collaboration 

 

5. When you have multiple pages on your 
site, it can be tedious to apply the same 
style to all of them. Which method is ideal 
for applying one style to multiple pages? 

a. Duplicate styling 

b. Internal style sheet 

c. Inline styling 

d. External style sheet 

 

  

http://gmetrix.com/


Web Authoring Using Adobe Dreamweaver CC Study Guide 

 

 
Adobe, the Adobe logo, Adobe Photoshop and Creative Cloud are either registered trademarks or trademarks of Adobe Systems 
Incorporated in the United States and/or other countries. All other trademarks are the property of their respective owners. 
 
© 2017 Adobe Systems Incorporated. All rights reserved. 

19 

Simulation Questions 
When taking the actual exam, you will complete each of the tasks with your mouse in a simulated 
manner, but for this study guide we recommend that you practice by writing out the steps. In the space 
provided. 

1. Add the file Logo.png as a Favorite in the Assets panel. 
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2. Add the alternate text Glacier to the image. 
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3. Use the Insert panel to add an email link on the word Contact to contact@ci.com. 
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4. Styling the actual text on a web page is an important part of design for the entire site. Using 
the Properties panel, set the text Creative Intelligence to the h4 Heading style. 
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5. You want to add a background image to your site to give it more of a handmade, crafty feel. 
Set the image seamlessWoodPattern.jpg as a repeating background image for the web page. 
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Answer Key  
Selected Response Questions 

1. c 

2. a, b, c 

3. a, b, c 

4. d 

5. d 

Answer Key for Simulation Questions 
(answers below outline the steps to 
complete each simulation) 
Simulation 1 

1. Click on the tab for the Assets panel to 
expand it 

2. Right-click on Logo.png and select Add to 
Favorites 

3. Click OK 

Simulation 2 

1. Select the image by clicking on it 

2. At the bottom, in the properties panel, 
click inside the text input box next to alt 

3. Type Glacier 

Simulation 3 

1. Highlight the word Contact using your 
cursor 

2. Click Insert at the top of the page and 
then click the Email Link button 

3. In the text section type Contact 

4. In the Email section type contact@ci.com 

5. Click OK 

Simulation 4 

1. Click and drag to select the text Creative 
Intelligence 

2. In the Properties Panel, click the drop-

down menu for Format and select 
Heading 4 

OR 

1. In the menus, select Format > Paragraph 
Format > Heading 4 

Simulation 5 

1. Click the Page Properties button in the 
Properties Panel 

2. Select the Appearance (CSS) category 

3. Next to background image, click Browse 

4. Select seamlessWoodPattern.jpg and click 
OK 

5. In the drop-down menu next to repeat, 
select Repeat 

6. Click OK 

 

 

 

mailto:contact@ci.com
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